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Kit Contents 

Investigator Argus X-12 Kit (25) (100) 

Catalog no. 383213 383215 

Number of 25 µl reactions 25 100 

 Reaction Mix A 125 µl 500 µl 

Primer Mix Argus X-12 63 µl 250 µl 

Multi Taq2 DNA Polymerase 38 U 150 U 

Control DNA 9947A 200 µl 200 µl 

DNA size standard 550 (BTO) 13 µl 50 µl 

Allelic ladder Argus X-12 25 µl 25 µl 

Nuclease-free water 1.9 ml 2 x 1.9 ml 

Quick-Start Protocol 1 1 
 

Storage 
All components of the Investigator Argus X-12 Kit should be stored at –20°C. 
Avoid repeated thawing and freezing. Primer mix and allelic ladder must be 
stored protected from the light. DNA samples and post-PCR reagents (allelic 
ladder and DNA size standard) should be stored separately from the PCR 
reagents. Under these conditions, the components are stable until the expiration 
date indicated on the kit. 

Intended Use 
The Investigator Argus X-12 Kit is intended for molecular biology applications in 
forensic, human identity, and paternity testing. This product is not intended for 
the diagnosis, prevention, or treatment of a disease. 

All due care and attention should be exercised in the handling of the products. 
We recommend all users of QIAGEN® products to adhere to the NIH guidelines 
that have been developed for recombinant DNA experiments, or to other 
applicable guidelines. 
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Safety Information 
When working with chemicals, always wear a suitable lab coat, disposable 
gloves, and protective goggles. For more information, please consult the 
appropriate safety data sheets (SDSs). These are available online in convenient 
and compact PDF format at www.qiagen.com/safety where you can find, view, 
and print the SDS for each QIAGEN kit and kit component. 

24-hour emergency information 

Chemical emergency or accident assistance is available 24 hours a day from: 

CHEMTREC 

USA & Canada: Tel: 1-800-424-9300 

Outside USA & Canada:  Tel: +1-703-527-3887 (collect calls accepted) 
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Introduction 
The Investigator Argus X-12 Kit is a multiplex application for 12  
X-chromosomal short tandem repeat (STR) loci. The kit supplements the 
Investigator Argus Y-12 QS Kit for kinship and paternity testing, especially in 
complicated deficiency cases. Furthermore, the use of gonosomal STRs for the 
analysis of DNA traces in the forensic field is increasing. This kit is highly suited 
for analysis of forensic stains, such as female traces on a male background. 

The Investigator Argus X-12 Kit contains primers for Amelogenin (AM) for 
gender determination, DXS7132, DXS7423, DXS8378, DXS10074, DXS10079, 
DXS10101, DXS10103, DXS10134, DXS10135, DXS10146, DXS10148, and 
HPRTB. The markers are clustered into 4 linkage groups (3 markers per group; 
Table 1), and thus each set of 3 markers is handled as a haplotype for 
genotyping (Figure 1, next page).  

The primers are fluorescence-labeled with one of the following dyes: 

 6-FAM™: Amelogenin, DXS10103, DXS8378, DXS7132, DXS10134 

 BTG: DXS10074, DXS10101, DXS10135  

 BTY: DXS7423, DXS10146, DXS10079  

 BTR: HPRTB, DXS10148 

Table 1. Linkage groups 

Linkage group  

1 (Xp22)  DXS8378 – DXS10135 – DXS10148 

2 (Xp11)  DXS7132 – DXS10074 – DXS10079 

3 (Xp26)  HPRTB – DXS10101 – DXS10103 

4 (Xp28)  DXS7423 – DXS10134 – DXS10146 
 

 
The optimal amount of DNA under standard conditions is 0.2–0.5 ng. Internal 
validations demonstrated reliable results with <0.1 ng DNA. 

The Investigator Argus X-12 Kit was validated using the GeneAmp® PCR System 
9700 (with Gold-plated 96-Well Silver Block), ABI PRISM® 310, ABI PRISM 
3100, Applied Biosystems 3130, and Applied Biosystems 3500 Genetic 
Analyzers. 

The Forensic ChrX Research Group initiated the online data base ChrX-STR.org 
(http://www.chrx-str.org) that calculates population-genetic data on basis of 
X-chromosomal allele frequencies (1).  
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Figure 1. The ideogram of the X-chromosome describes the physical localization of 
the STR loci that can be analyzed using the Investigator Argus X-12 Kit. Distances from 
the p-telomere are shown in Mb (www.ncbi.nlm.nih.gov/genome/guide/human as of 
10/2009).  

 

Table 2 and Table 3 show the STR loci with their chromosomal mapping, repeat 
motifs, and alleles that are concordant with the International Society for 
Forensic Genetics (ISFG) guidelines for the use of microsatellite markers (2). 
Allele ranges include all known alleles of the National Institute of Standards and 
Technology (NIST as of 12/2008) and of the current literature. 
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Table 2. Locus-specific information of the Investigator Argus X-12 Kit 

 
 
Locus 

GenBank® 
Accession 
number  

 
Repeat motif 
of the reference allele 

 
Ref. 

allele 

 
Allele  
range 

Amelogenin X M55418 – – – 

Amelogenin Y M55419 – – – 

DXS7132 G08111 [TCTA]13 13 8–20 

DXS7423 AC109994 [TCCA]3 TCTGTCCT [TCCA]12  15 8–19 

DXS8378 G08098 [CTAT]12 12 7–15 

DXS10074 AL356358 [AAGA]14 14 4–21 

DXS10079 AL049564 [AGAG]3 TGAAAGAG [AGAA]17 
AGAG [AGAA]3 

21 14–25 

DXS10101 AC004383 

 

[AAAG]3 GAAAGAAG [GAAA]3 
A [GAAA]4 AAGA [AAAG]5 
AAAAAGAA [AAAG]13 AA 

28.2 24–38 

DXS10103 BV680555 

 

[TAGA]2 CTGA 
[CAGA][TAGA]11[CAGA]4[TAGA] 

19 15–21 

DXS10134 AL034384 [GAAA]3 GAGA [GAAA]4 AA 
[GAAA] GAGA [GAAA]4 GAGA 
[GACAGA]3 [GAAA] GTAA 
[GAAA]3 AAA [GAAA]4 AAA 
[GAAA]15 

35 28–46.1 

DXS10135 AC003684 [AAGA]3 GAAAG [GAAA]20 23 13–39.2 

DXS10146 AL034384 [TTCC]3 T [TTCC]3 TTTC 
CTCCCTTCC [TTCC] [TCCC] 
TTCTTCTTTC [TTCC]2 TTTCTT 
[CTTT]2 CTTC [CTTT]10 T [CTTT]2 

26 24–46.2 

DXS10148 AC003684 [GGAA]4[AAGA]12[AAAG]4 N8 
[AAGG]2 

22 13.3–38.1 

HPRTB M26434 [AGAT]12* 12 6–19 
 

* [AGAT] is the most common repeat structure; for variations see the NIST and reference 3. 
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Table 3. Chromosomal mapping of Investigator Argus X-12 Kit 

Locus Chromosomal mapping 

Amelogenin X Xp22.1-22.3 

Amelogenin Y Yp11.2 

DXS7132 Xq11.2 

DXS7423 Xq28 

DXS8378 Xp22.31 

DXS10074 Xq12 

DXS10079 Xq12 

DXS10101 Xq26.2 

DXS10103 Xq26.2 

DXS10134 Xq28 

DXS10135 Xp22.31 

DXS10146 Xq28 

DXS10148 Xp22.31 

HPRTB Xq26.2 
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Equipment and Reagents to Be Supplied by User 
When working with chemicals, always wear a suitable lab coat, disposable 
gloves, and protective goggles. For more information, consult the appropriate 
safety data sheets (SDSs), available from the product supplier. 

 Hi-Di™ Formamide, 25 ml (Applied Biosystems®, cat. no. 4311320) 

 Matrix Standards BT5 for single-capillary instruments, e.g., ABI PRISM 310 
Genetic Analyzer (QIAGEN, cat. no. 386113) 

 Matrix Standards BT5 for multi-capillary instruments, e.g., ABI PRISM 3100 
and Applied Biosystems 3130 and 3500™ Genetic Analyzers (QIAGEN, 
cat. nos. 386123 or 386125) 

 Pipets and pipet tips 

 One of the following DNA analyzers: 
ABI PRISM 310 Genetic Analyzer 
ABI PRISM 3100-Avant™/3100 Genetic Analyzer 
Applied Biosystems 3130/3130xl Genetic Analyzer 
Applied Biosystems 3500/3500xL Genetic Analyzer 

 One of the following PCR thermal cyclers:  
QIAGEN Rotor-Gene® Q 
GeneAmp PCR System 9700 
Bio-Rad PTC-200 
Techne TC-512 
Biometra T1 
Eppendorf® Mastercycler® ep 

 PCR tubes or plates 

Validity analysis software for human identification products 

Investigator Human Identification PCR Kits require calibration with an allelic 
ladder. Therefore, the software used must be compatible with human 
identification (HID) products for forensic applications. We recommend 
Investigator IDproof Software, Investigator IDproof Mixture Software, 
GeneMapper® ID, GeneMapper ID-X, or Genotyper® Software. The Investigator 
Template Files facilitate data analysis and are compatible with the software 
mentioned above. 
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Protocol: PCR Amplification 
This protocol is for PCR amplification of STR loci from forensic samples using 
the Investigator Argus X-12 Kit. 

Important points before starting 

 Set up all reaction mixtures in an area separate from that used for DNA 
isolation and PCR product analysis (post-PCR). 

 Use disposable tips containing hydrophobic filters to minimize cross-
contamination. 

Things to do before starting 

 Before opening the tubes with PCR components, vortex, and then centrifuge 
briefly to collect contents at the bottom of the tubes. 

Procedure 

1. Thaw PCR components and template nucleic acid. 
Mix thoroughly before use. 

2. Prepare a master mix according to Table 4. 
The master mix contains all of the components needed for PCR except the 
template (sample) DNA and nuclease-free water. 

Prepare a volume of master mix 10% greater than that required for the total 
number of PCR assays to be performed. This should include positive and 
negative control reactions.  

3. Mix the master mix thoroughly, and dispense appropriate volumes 
into PCR tubes or the wells of a PCR plate. 

4. Add template DNA and nuclease-free water to the master mix, to 
give a final sample volume of 25 µl.  

5. Prepare positive and negative controls. 
Positive control: Use 5 µl of the Control DNA. 

Negative control: Use nuclease-free water instead of template DNA in the 
reaction. 
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Table 4. Reaction setup 

Component Volume per reaction 

Reaction Mix A* 5.0 µl 

Primer Mix 2.5 µl 

Multi Taq2 DNA Polymerase 0.6 µl 

Nuclease-free water (added in step 4) Variable 

Template DNA (added in step 4) Variable 

Total volume 25 µl 
 

* Contains dNTP mix, MgCl2, and bovine serum albumin (BSA). 
 

6. Program the thermal cycler according to the manufacturer’s 
instructions, using the conditions outlined in Table 5. 
For stains containing small amounts of DNA (<100 pg/25 µl reaction), we 
recommend using the cycling conditions outlined in Table 6. 

Note: If using the GeneAmp PCR System 9700 with an Aluminum block, 
use “Std Mode”, or with a Silver 96-Well Block or Gold-plated Silver 
96-Well Block, use “Max Mode”. Do not use “9600 Emulation Mode”.  

Table 5. Standard cycling protocol, recommended for all DNA samples  

Temperature Time Number of cycles 

94°C*  4 min – 

96°C 

63°C 

72°C 

30 s 

120 s 

75 s 

 

5 cycles 

94°C 

60°C 

72°C 

30 s 

120 s 

75 s 

 

25 cycles 

68°C 60 min – 

10°C ∞ – 
 

* Hot-start to activate DNA polymerase. 
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Table 6. Optional cycling protocol, recommended for stains containing 
small amounts (<100 pg) of DNA 

Temperature Time Number of cycles 

94°C* 4 min – 

96°C 

63°C 

72°C 

30 s 

120 s 

75 s 

 

5 cycles 

94°C 

60°C 

72°C 

30 s 

120 s 

75 s 

 

27 cycles 

68°C 60 min – 

10°C ∞ – 
 

* Hot-start to activate DNA polymerase. 
 

7. After the cycling protocol is completed, store samples at –20°C 
protected from the light, or proceed directly with electrophoresis. 
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Protocol: Electrophoresis Using the ABI PRISM 310 
Genetic Analyzer 
For general instructions on instrument setup, matrix generation, and application 
of the GeneScan® or GeneMapper ID Software, refer to the ABI PRISM 310 
Genetic Analyzer User’s Manual. Electrophoresis using the GeneScan Software 
is described below.  

The virtual filter set G5 is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 7. 

Table 7. Materials required for electrophoresis 

Material Specifications 

Capillary 47 cm/50 µm (green) 

Polymer POP-4™ for ABI PRISM 310 Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Matrix generation 
Before conducting DNA fragment size analysis with the filter set G5, a matrix 
with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO must be 
generated (Table 8).  

Table 8. The fluorescent labels of BT5 

Color Matrix standard 

Blue (B) 6-FAM 

Green (G) BTG 

Yellow (Y) BTY 

Red (R) BTR 

Orange (O) BTO 
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1. Five electrophoresis runs should be conducted, one for each 
fluorescent label, under the same conditions as for the samples and 
allelic ladders of the Investigator Argus X-12 Kit, in order to generate 
suitable matrix files (Table 9).  

Table 9. Matrix setup for ABI single capillary instrument (ABI PRISM 310 
Genetic Analyzer) 

Matrix sample Component Volume 

Matrix sample 1 Hi-Di Formamide 

Matrix standard 6-FAM 

12.0 µl 

1.0 µl 

Matrix sample 2 Hi-Di Formamide 

Matrix standard BTG 

12.0 µl 

1.0 µl 

Matrix sample 3 Hi-Di Formamide 

Matrix standard BTY 

12.0 µl 

1.0 µl 

Matrix sample 4 Hi-Di Formamide 

Matrix standard BTR 

12.0 µl 

1.0 µl 

Matrix sample 5 Hi-Di Formamide 

Matrix standard BTO 

12.0 µl 

1.0 µl 
 

 
2. Denature for 3 min at 95°C. 
3. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

4. Load the samples on the tray. 
5. Create a Sample Sheet and enter the sample designation. Table 10 

shows the injection list for matrix generation. 

Investigator Argus X-12 Handbook   06/2013 15 



Table 10. Injection list for matrix generation 

Parameter Settings 

Module File GS STR POP-4 (1 ml) G5 

Matrix File None 

Size Standard None* 

Injection Time (s) 5 

Injection Voltage (kV) 15 

Run Voltage (kV) 15 

Run Temperature (°C) 60 

Run Time (min) 24 
 

* Always prepare matrix standards without DNA Size Standard (BTO). 
 

Analysis of the matrix samples 

1. Run the GeneScan Software. 
2. Select “New” from the File menu, and then select “Project”.  
3. Open the folder of the current run and select “Add Sample Files”. 
4. Select a matrix sample in the “Sample File” column. 
5. Click “Sample” and then “Raw Data”. 
6. Check the matrix samples for a flat baseline. As shown in the figure 

(next page), there should be at least 5 peaks with peak heights of 
1000–4000 RFU for each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 
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Electropherogram with raw data of the matrix standard 6-FAM. 

 

7. Select an analysis range with a flat baseline and re-inject the matrix 
sample, if necessary. 

8. Record start and end value (data points) of the analysis range; e.g., 
start value 3200, end value 5500. 

9. Calculate the difference between the end and start values; e.g., 
5500–3200=2300 data points. 

Generation of a matrix 

1. Select “New” in the “File” menu, and then select “Matrix”. 
2. Import the matrix samples for all dyes (B, G, Y, R, and O). 
3. Enter a “Start At” value, e.g., 3200. 
4. Under “Points”, enter the calculated difference between end and 

start values, e.g., 2300. 
5. Click “OK” to calculate the new matrix. 

 

 
Matrix sample selection. 

 

▼ 3200 data points (X) 

             5500▼ 
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6. Select “Save as” in the “File” menu to save the new matrix in the 
matrix folder. 
 

 
New matrix BT5. 

 

Checking the matrix 

1. To check the new matrix with current samples, select “New” in the 
“File” menu, and then select “Project”. 

2. Open the folder of the respective run and select “Add Sample Files”. 
3. Select the sample(s) in the “Sample File” column. 
4. Click “Sample” and then “Install New Matrix” to open the matrix 

folder and select the new matrix. 
5. Re-analyze the samples. 

Note: There should be no pull-up peaks between the dye panels (B, G, Y, 
R, O) with the new matrix. 

 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 11. 

Table 11. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12.0 µl 

DNA Size Standard 550 (BTO) 0.5 µl 
 

 
2. Aliquot 12 µl of the mixture to a tube for each sample to be 

analyzed. 
3. Add 1 µl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
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5. Snap freeze by placing the plate on ice for 3 min. 
Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
 
Setting up the GeneScan Software 
Create a Sample Sheet and enter sample designation. 

Table 12. Injection list for the ABI PRISM 310 Genetic Analyzer 

Component Settings 

Module File GS STR POP-4 (1 ml) G5 

Matrix File e.g., Matrix BT5 

Size Standard e.g., SST-BTO_60-400bp 

Injection Time (s) 5* 

Injection Voltage (kV) 15 

Run Voltage (kV) 15 

Run Temperature (°C) 60 

Run Time (min) 26† 
 

* Deviating from standard settings, the injection time may range between 1 and 10 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
up to 10 s may be necessary.  

† The run time for Investigator Argus X-12 was modified in order to be able to analyze 
fragments with lengths of up to 400 bp. 
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Analysis parameters 
Table 13 lists the recommended analysis parameters. 

Table 13. Recommended analysis parameters for the ABI PRISM 310 
Genetic Analyzer 

Parameter Settings 

Analysis Range Start: 2000 

Stop: 10,000 

Data Processing Baseline: Checked 

Multi-component: Checked 

Smooth options: Light 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Size Call Range Min: 60 

Max: 550 

Size Calling Method Local Southern Method 

Split Peak Correction None 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be 
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50–200 RFU and 
should be determined individually by the laboratory. Recommendation: The minimal peak height 
should be three-times as high as the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 

Note: For information on the use of the recommended Template Files (as 
analysis parameters), refer to the appropriate Investigator Template Files User 
Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X).  
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Protocol: Electrophoresis Using the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

For detailed instructions on instrument setup, spectral calibration, application of 
the ABI PRISM 3100 Data Collection Software version 1.01 or 1.1 and the 
GeneScan Software, refer to the ABI PRISM 3100-Avant/3100 Genetic Analyzer 
User’s Manual.  

The system with 4 capillaries is the ABI PRISM 3100-Avant Genetic Analyzer, 
and the system with 16 capillaries is the ABI PRISM 3100 Genetic Analyzer.  

The virtual filter set G5 is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 14. 

Table 14. Materials required for electrophoresis 

Material Specifications 

Capillary 36 cm Capillary Array for ABI PRISM 3100-Avant/3100 
Genetic Analyzer 

Polymer POP-4 Polymer for ABI PRISM 3100-Avant/3100 
Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Spectral calibration/matrix generation 
Proper spectral calibration is critical for evaluation of multicolor systems with the 
ABI PRISM 3100-Avant/3100 Genetic Analyzer and should be done before 
conducting fragment length analysis. The calibration procedure creates a matrix 
which is used to correct the overlapping of fluorescence emission spectra of the 
dyes.  

Spectral calibration comprises the following steps: 

 Preparation of the spectral calibration standards 

 Loading the standards to the 96-well reaction plate (one sample per 
capillary) 

 Entering the plate composition 

 Performing a spectral calibration run and checking the matrix 
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Preparing the spectral calibration standards 

Example for 4 capillaries (ABI PRISM 3100-Avant Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 15. 

Table 15. Setup of formamide and Matrix Standard BT5 mixture for 
4 capillaries 

Component Volume 

Hi-Di Formamide 60 µl 

Matrix Standard BT5 multi cap. 5 µl 
 

 
2. Load 12 µl of the mixture to 96-well plate; e.g., position A1–D1. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 16 capillaries (ABI PRISM 3100 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 16. 

Table 16. Setup of formamide and Matrix Standard BT5 mixture for 
16 capillaries 

Component Volume 

Hi-Di Formamide 204 µl 

Matrix Standard BT5 multi cap. 17 µl 
 

 
2. Load 12 µl of the mixture to 96-well plate; e.g., position A1–H1 and 

A2–H2. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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Performing a spectral calibration run 

The parameter file for DyeSetG5 must be modified once to achieve successful 
calibration with the Data Collection Software version 1.0.1 or 1.1. 

Spectral parameter 

1. To change settings in the parameter file, go to the following path: 
D:\AppliedBio\Support Files\Data Collection 
SupportFiles\CalibrationData\Spectral Calibration\ParamFiles 

2. Select “MtxSTD{Genescan_SetG5}” to open the PAR file. 
3. Change “Condition Bounds Range” to [1.0, 20.0]. 
4. If the calibration was unsuccessful, also change Sensitivity to 0.1 and 

Quality to 0.8. 
5. Select “Save As” in the “File” menu and save the parameter file 

under a new name; e.g., MtxStd{Genescan_SetG5_BT5}.par. 
Note: Always use this parameter file for spectral calibration runs using 
QIAGEN Matrix Standard BT5. 

Plate Editor for spectral calibration 

1. Place the 96-well plate on the autosampler tray. 
2. Run the ABI PRISM 3100 Data Collection Software. 
3. In “Plate View”, click “New” to open the Plate Editor dialog box. 
4. Enter a name for the plate. 
5. Select a Spectral Calibration. 
6. Select “96-Well” as plate type, and click “Finish”. 

Table 17. Plate Editor for spectral calibration 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Dye Set G5 

Spectral Run Module Default (e.g., Spect36_POP4) 

Spectral Parameters MtxStd{GeneScan_SetG5_BT5}.par 
(parameters created before) 

 

 
7. Click the column header to select the entire column, and select “Fill 

Down” from the Edit menu to apply the information to the selected 
samples. Confirm by clicking “OK”. 
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8. Link the reaction plate on the autosampler tray with the created 
plate ID and start the run. 

9. Upon completion of the run, check in the Spectral Calibration Result 
dialog box that all capillaries have successfully passed calibration 
(label A).  
If individual capillaries are labeled X, refer to the ABI PRISM 3100 Genetic 
Analyzer User’s Manual. 

10. Click “OK” to confirm completion of the run. 

Checking the matrix 

1. Select “Display Spectral Calibration” from the “Tools” menu, then 
“Dye Set” and “G5” to review the spectral calibration profile for 
each capillary. 

2. The quality value (Q value) must be greater than 0.95 and the 
condition number (C value) must be between 1 and 20. Both values 
must be within the pre-determined range. 

3. Check for a flat baseline in the matrix samples. There should be five 
peaks with heights of 1000–5000 RFU in each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 

4. Check the new matrix with the current samples. There should be no 
pull-up peaks between the dye panels (B, G, Y, R, and O) with the 
new matrix. 

5. If the calibration failed, follow instructions in the section “Spectral 
parameter” on page 23. 

6. If all capillaries have passed the calibration, the last calibration file 
for Dye Set G5 must be activated manually. Go to “Tools” and click 
“Set Active Spectral Calibration”. 

7. Rename the calibration file under “Set Matrix Name” (e.g., BT5_Date 
of calibration). 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 18. 

Table 18. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12 µl 

DNA Size Standard 550 (BTO) 0.5 µl 
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2. Aliquot 12 µl of the mixture to a tube for each sample to be 
analyzed. 

3. Add 1 µl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
 
Since injections take place simultaneously on all capillaries, 4 or 16 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples 
are analyzed, the empty positions must be filled with 12 µl Hi-Di Formamide. 

To ensure a reliable allelic assignment on multi-capillary analyzers, several 
ladders should be run. 

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur especially at 
low temperatures. Ensure ambient conditions are kept as recommended by the 
instrument manufacturer. 

Setting up the GeneScan Software 
7. Edit the default run module in Dye Set G5 once for the first run. 

Select “Module Editor” to open the dialog box. 
8. Select the appropriate Run Module as template from the GeneScan 

table (see Table 19). 
9. Modify the Injection Voltage to 3 kV and the Injection Time to 10 s. 
10. Click “Save As” and enter the name of the new module (e.g., 

3kV_10s_400bp). Confirm by clicking “OK”. 
11. Click “Close” to exit the Run Module Editor. 
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Table 19. Run Module 3kV_10s_400bp for the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

Parameter Setting 

Run Temperature (°C) Default 

Cap Fill Volume Default 

Maximum Current (A) Default 

Current Tolerance (A) Default 

Run Current (A) Default 

Voltage Tolerance (kV) Default 

Pre-Run Voltage (kV) Default 

Pre-Run Time (s) Default 

Injection Voltage (kV) 3.0 

Injection Time (s) 10* 

Run Voltage (kV) Default 

Number of Steps Default 

Voltage Step Interval Default 

Data Delay Time (s) Default 

Run Time (min) 20† 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary.  

† The run time for Investigator Argus X-12 was modified in order to be able to analyze 
fragments with lengths of up to 400 bp. 

Starting the run 

1. Place the prepared 96-well plate on the autosampler tray. 
2. Run the ABI PRISM 3100 Data Collection Software. 
3. In “Plate View”, click “New” to open the Plate Editor dialog box. 
4. Enter a name for the plate. 
5. Select “GeneScan” as the application type. 
6. Select “96-Well” as plate type, and click “Finish”. 
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Table 20. Settings in Plate Editor 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Dyes O 

Color Info Ladder or sample 

Project Name e.g., 3100_Project1 

Dye Set G5 

Run Module* 3kV_10s_400bp 

Analysis Module 1 DefaultAnalysis.gsp 
 

* See Table 19, “Run Module 3kV_10s_400bp for the ABI PRISM 3100-Avant/3100 Genetic 
Analyzer”. 
 
7. Complete the table in the “Plate Editor” and click “OK”. 
8. Click the column header to highlight the entire column and select 

“Fill Down” from the “Edit” menu to apply the information to the 
selected samples. 

9. Link the reaction plate on the autosampler tray to the created plate 
ID and start the run. 

10. Upon completion of the run, view the data as Color Data in the 
Array View of the 3100 Data Collection Software or as Analyzed 
Sample Files under D:/AppliedBio/3100/DataExtractor/ExtractRuns. 
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Analysis parameters 
Table 21 lists the recommended analysis parameters. 

Table 21. Recommended analysis parameters for the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

Parameter Settings 

Analysis Range Start: 2000 

Stop: 10,000 

Data Processing Baseline: Checked 

Multi-component: Checked 

Smooth options: Light 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Size Call Range Min: 60 

Max: 550 

Size Calling Method Local Southern Method 

Split Peak Correction None 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be 
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50–200 RFU and 
should be determined individually by the laboratory. Recommendation: The minimal peak height 
should be three-times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 
Note: For information on the use of the recommended Template Files (as 
analysis parameters), refer to the appropriate Investigator Template Files User 
Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X). 
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Protocol: Electrophoresis Using the Applied 
Biosystems 3130/3130xl Genetic Analyzer 
For detailed instructions on instrument setup, spectral calibration, or application 
of the ABI PRISM Data Collection Software version 3.0 and the GeneMapper ID 
Software, refer to the Applied Biosystems 3130/3130xl Genetic Analyzers 
Getting Started Guide.  

The system with 4 capillaries is the Applied Biosystems 3130 Genetic Analyzer, 
and the system with 16 capillaries is the Applied Biosystems 3130xl Genetic 
Analyzer. 

The virtual filter set Any5Dye is used for combined application of the 5 
fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is 
known as BT5.  

The materials required for electrophoresis are given in Table 22. 

Table 22. Materials needed for electrophoresis 

Material Specifications 

Capillary 36 cm Capillary Array for Applied Biosystems 
3130/3130xl Genetic Analyzer 

Polymer POP-4 Polymer for Applied Biosystems 3130/3130xl 
Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Spectral calibration/matrix generation 
Before conducting DNA fragment size analysis, it is necessary to perform a 
spectral calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and 
BTO for each analyzer. The calibration procedure creates a matrix which is 
used to correct the overlapping of fluorescence emission spectra of the dyes.  

Spectral calibration is comprised of the following steps: 

 Preparation of the spectral calibration standards 

 Loading the standards to the 96-well reaction plate (one sample per 
capillary) 

 Creating the instrument protocol for spectral calibration (Protocol Manager) 

 Defining the plate composition in the plate editor (Plate Manager) 

 Performing a spectral calibration run and checking the matrix 
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Preparing the spectral calibration standards 

Example for 4 capillaries (Applied Biosystems 3130 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 23. 

Table 23. Setup of formamide and Matrix Standard BT5 mixture for 
4 capillaries 

Component Volume 

Hi-Di Formamide 60 µl 

Matrix Standard BT5 multi cap. 5 µl 
 

 
2. Load 12 µl of the mixture to 96-well plate, e.g., positions A1–D1. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 16 capillaries (Applied Biosystems 3130xl Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 23. 

Table 24. Setup of formamide and Matrix Standard BT5 mixture for 
16 capillaries 

Component Volume 

Hi-Di Formamide 204 µl 

Matrix Standard BT5 multi cap. 17 µl 
 

 
2. Load 12 µl of the mixture to 96-well plate, e.g., position A1–H1 and 

A2–H2. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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Performing spectral calibration run 
1. Place the 96-well plate on the autosampler tray. 
2. In the Protocol Manager of the Data Collection Software, open the 

Instrument Protocol window. 
3. Click “New” to open the Protocol Editor dialog box. 
4. Complete the dialog box with information from Table 25 and click 

“OK”. 

Table 25. Instrument protocol for spectral calibration 

Protocol Editor Settings 

Name User (e.g., Spectral36_POP4_BT5) 

Type SPECTRAL 

Dye Set Any5Dye 

Polymer User (e.g., POP4)* 

Array Length User (e.g., 36cm)* 

Chemistry Matrix Standard 

Run Module Default (e.g., Spect36_POP4_1)* 
 

* Depends on the type of polymer and length of capillary used. 
 
5. Click “New” in the Plate Manager of the Data Collection Software to 

open the “New Plate” dialog box. 
6. Enter information from Table 26 and click “OK”. A new table in the 

Plate Editor opens automatically (Table 27). 

Table 26. Plate Editor for spectral calibration (I) 

New plate dialog Settings 

Name e.g., Spectral_BT5_date 

Application Spectral Calibration 

Plate Type 96-well 

Owner Name/ 
Operator Name 

… 
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 Table 27. Plate Editor for spectral calibration (II) 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Priority e.g., 100 

Instrument Protocol 1 Spectral36_POP4_BT5 (setting described before) 
 

 
7. Click the column header to select the entire column, and select “Fill 

Down” from the “Edit” menu to apply the information to the selected 
samples. Confirm by clicking “OK”. 

8. Link the reaction plate on the autosampler tray with the created 
plate ID (position A or B) and start the run. 

 

 
Electropherogram of spectral calibration with matrix standard BT5 on an Applied 
Biosystems 3130 Genetic Analyzer. 

 

 

    O            R            Y        G        B 
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Checking the matrix 

1. The quality value (Q value) of each capillary must be greater than 
0.95 and the condition number range (C value) must be between 1 
and 20. 

2. Check for a flat baseline in the matrix samples. As shown in the 
figure on the previous page, there should be 5 peaks with peak 
heights of about 1000–5000 RFU in each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 

3. Check the new matrix with the current samples. There should be no 
pull-up peaks between the dye panels (B, G, Y, R, O) with the new 
matrix. 

4. If calibration failed, use the optimized values of the Matrix Standard 
BT5 and repeat the calibration run. 

5. If all capillaries have passed the test, the last calibration file for the 
Dye Set Any5Dye is activated automatically in the Spectral Viewer. 
Rename the calibration file (e.g., BT5_Date of calibration). 

 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 28. 

Table 28. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12 µl 

DNA Size Standard 550 (BTO) 0.5 µl 
 

 
2. Aliquot 12 µl of the mixture to a tube for each sample to be 

analyzed. 
3. Add 1 µl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
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Since injections take place simultaneously on all capillaries, 4 or 16 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples 
are analyzed, the empty positions must be filled with 12 µl Hi-Di Formamide. 

To ensure a reliable allelic assignment on multi-capillary analyzers, several 
ladders should be run. 

Room temperature may influence the performance of PCR products on multi- 
capillary instruments, so that shoulder peaks or split peaks occur especially at 
low temperatures. Ensure ambient conditions are kept, as recommended by the 
instrument manufacturer. 

Setting up the Data Collection Software 
7. Edit the Run Module once for the first run. In the Module Manager of 

the Data Collection Software, click “New” to open the “Run Module 
Editor” dialog box. 
Note: Modify the Run Module Default settings from 
“HIDFragmentAnalysis36_POP4_1” to those shown in Table 29 . 

8. Modify the Injection Voltage to 3 kV and the Injection Time to 10 s 
(Table 29). 

9. Click “Save As”, enter a name for the new Run Module  
(e.g., 3kV_10s_400bp), and confirm by clicking “OK”. 

10. Click “Close” to exit the Run Module Editor. 
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Table 29. Run Module 3kV_10s_400bp for Applied Biosystems 
3130/3130xl Genetic Analyzer 

Parameter Settings 

Oven Temperature (°C) Default 

Poly Fill Volume Default 

Current Stability (µA) Default 

Pre-Run Voltage (kV) Default 

Pre-Run Time (s) Default 

Injection Voltage (kV) 3.0 

Injection Time (s) 10* 

Voltage Number of Steps Default 

Voltage Step Interval Default 

Data Delay Time (s) Default 

Run Voltage (kV) Default 

Run Time (s) 1200† 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary.  

† The run time for Investigator Argus X-12 was modified in order to be able to analyze 
fragments with lengths of up to 400 bp. 

Starting the run 

1. Place the prepared 96-well plate on the autosampler tray. 
2. Open the Protocol Manager of the Data Collection Software. 
3. Click “New” in the Instrument Protocol window to open the Protocol 

Editor dialog box and enter the information in Table 30. 
4. Click “OK” to exit the Protocol Editor. 
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Table 30. Settings in Instrument Protocol 

Protocol Editor Settings 

Name Run36_POP4_BT5_20min 

Type REGULAR 

Run Module 3kV_10s_400bp* 

Dye Set Any5Dye 
 

* See Table 29, “Run Module 3kV_10s_400bp for Applied Biosystems 3130/3130xl Genetic 
Analyzer”. 
 

5. Before each run, it is necessary to create a plate definition. In the 
Plate Manager of the Data Collection Software, click “New” to open 
the “New Plate” dialog box. 

6. Enter the information in Table 31. 

Table 31. GeneMapper Plate Editor (I) 

Protocol Editor Settings 

Name e.g., Plate_BT5_Date 

Application Select GeneMapper Application 

Plate type 96-Well 

Owner Name/ 
Operator Name 

… 

 

 
7. Click “OK” and a new table in the Plate Editor opens automatically 

(Table 32). 
8. Click the column header to select the entire column. Select “Fill 

Down” from the “Edit” menu to apply the information to all selected 
samples. Click “OK”. 

9. In the Run Scheduler, click “Find All”, and select “Link” to link the 
reaction plate on the autosampler tray to the newly created plate 
record (position A or B). 
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Table 32. GeneMapper Plate Editor (II) 

Parameter Settings 

Sample Name Enter the name for the samples 

Priority e.g., 100 (Default) 

Sample Type Sample or Allelic Ladder 

Size Standard e.g., SST-BTO_60-400bp 

Panel e.g., Argus_X12_Panels 

Analysis Method e.g., Analysis_HID_3130 

Snp Set – 

User-defined 1-3 – 

Results Group 1 (Select results group) 

Instrument Protocol 1 Run36_POP4_BT5_20min (setting described 
before) 

 

 
10. Start the run. 
11. During the run, view Error Status in the Event Log or examine the 

quality of the raw data for each capillary in the Capillaries Viewer or 
the Cap/Array Viewer. 

12. View data as an overview in Run History or Cap/Array Viewer of the 
Data Collection Software.  
Run data are saved in the Run Folder of the previously chosen Result Group. 
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Analysis parameters/analysis method 
Table 33 lists the recommended analysis parameters in the worksheet Peak 
Detector. 

Table 33. Recommended settings for the Applied Biosystems 
3130/3130xl Genetic Analyzer 

Parameter Settings 

Peak Detection Algorithm Advanced 

Ranges Analysis: Partial Range 

Start Point: 2000; Stop Point: 10,000 

Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  

Baseline Window: 51 pts 

Size Calling Method Local Southern Method 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Slope Thresholds: 0.0 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that 
will be detected by the GeneMapper ID Software. The thresholds are usually 50–200 RFU 
and should be determined individually by the laboratory. Recommendation: The minimal 
peak height should be three-times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 
Note: For information on the use of the recommended Template Files (as 
analysis parameters), refer to the appropriate Investigator Template Files User 
Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X). 
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Protocol: Electrophoresis Using the Applied 
Biosystems 3500/3500xL Genetic Analyzer 
For detailed instructions on instrument setup, spectral calibration, or application 
of the Applied Biosystems 3500 Series Data Collection Software version 1.0 and 
the GeneMapper ID-X Software version 1.2, refer to the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide.  

The system with 8 capillaries is the Applied Biosystems 3500 Genetic Analyzer 
and the system with 24 capillaries is the Applied Biosystems 3500xL Genetic 
Analyzer. 

The virtual filter set AnyDye is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 31. 

Table 34. Materials required for electrophoresis 

Material Specifications 

Capillary 36 cm Array for Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Polymer POP-4 for Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Buffer Anode Buffer Container (ABC) 3500 Series 
Cathode Buffer Container (CBC) 3500 Series 

 

Spectral calibration/matrix generation 
Before conducting DNA fragment size analysis, it is necessary to perform a 
spectral calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and 
BTO for each analyzer (Table 35). The calibration procedure creates a matrix 
which is used to correct the overlapping of fluorescence emission spectra of the 
dyes.  

IMPORTANT: Spectral calibration must be performed for each new capillary 
array. 

Spectral calibration is comprised of the following steps: 

 Preparation of the instrument 

 Preparation of dye set BT5 

 Preparation of the standard calibration plate 

 Plate assembly and loading the plate in the instrument 
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 Performing a spectral calibration run 

 Checking the matrix 

Preparation of the instrument 

Before the spectral calibration process, ensure that the spatial calibration has 
been performed. This process is described in detail in the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 

Preparation of dye set BT5 

Table 35. The 5 fluorescent labels of BT5 

Color Matrix standard 

Blue (B) 6-FAM 

Green (G) BTG 

Yellow (Y) BTY 

Red (R) BTR 

Orange (O) BTO 
 

 

Prior to the spectral calibration, a dye set for the Matrix Standard BT5 must be 
set up. 

 

1. To create a new dye set, go to “Library” and select “Analyze”, 
followed by “Dye Sets” and click “Create”. 

2. Enter a “Dye Set Name”, e.g., BT5. 
3. Select “Matrix Standard” as a chemistry and “AnyDye Template” as a 

dye set template. 
4. Disable “Purple” in the field “Arrange Dyes”. Ensure that all other 

colors are enabled. 
5. Under “Calibration Peak Order” the colors need to be arranged as 

follows: 5 — blue, 4 — green, 3 — yellow, 2 — red, and 1 — orange. 
6. Do not alter the “Parameter” settings. 
7. Click “Save” to confirm the changes. 
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Setup of dye set BT5. 

Preparation of the standard calibration plate 

Example for 8 capillaries (Applied Biosystems 3500 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 36. 

Table 36. Setup of formamide and Matrix Standard BT5 mixture for 
8 capillaries 

Component Volume 

Hi-Di Formamide 90 µl 

Matrix Standard BT5 multi cap. 10 µl 
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2. Load 10 µl of the mixture to a 96-well plate, e.g., positions A1–H1. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 24 capillaries (Applied Biosystems 3500xL Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 37. 

Table 37. Setup of formamide and Matrix Standard BT5 mixture for 
24 capillaries 

Component Volume 

Hi-Di Formamide 225 µl 

Matrix Standard BT5 multi cap. 25 µl 
 

 
2. Load 10 µl of the mixture to a 96-well plate, e.g., positions A1–H1, 

A2–H2, and A3–H3. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Plate assembly and loading the plate in the instrument 

The necessary steps are described in detail in the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 

Performing a spectral calibration run 

Once the multiwell plates containing the spectral calibration mixture are placed 
in the autosampler tray, the spectral calibration process can be started. 

1. To access the Spectral Calibration screen, select “Maintenance” on 
the Dashboard of the 3500 Series Data Collection software. 

2. The number of wells in the spectral calibration plate and their 
location in the instrument must be specified. 

3. Select “Matrix Standard” as a chemistry standard and “BT5” for dye 
set. 

4. (Optional) Enable “Allow Borrowing”. 
5. Click “Start Run”. 
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Checking the matrix 

Click a capillary in the table in order to display the results for each capillary 
(spectral data, Quality value, and Condition Number) below the run results table. 

 The quality value (Q value) of each capillary must be greater than 0.8 and 
the number range (C value) must be between 1 and 20. 

 Check the matrix samples for a flat baseline. As shown in the figure, there 
should be 5 peaks with peak heights of about 1000–5000 RFU for each 
matrix sample (Note: The optimal range is 2000–4000 RFU). 

 

 

Electropherogram of spectral calibration of the matrix standard BT5 on an Applied 
Biosystems 3500 Genetic Analyzer. 
 

When a spectral calibration is successfully completed, the “Overall” row 
displays green results. If the “Overall” row displays red results, refer to the 
“spectral calibration troubleshooting” section of the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 

 

 
 

Example for a successful spectral calibration of the matrix standard BT5 for all 
capillaries on an Applied Biosystems 3500 Genetic Analyzer.  
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For each capillary, select and display the spectral and raw data. Check that the 
data meet the following criteria: 

 The order of the peaks in the spectral profile from left to right read orange-
red-yellow-green-blue 

 No extraneous peaks appear in the raw data profile 

 Peak morphology in the spectral profile shows no gross overlaps, dips, or 
other irregularities. Separate and distinct peaks should be visible 

If the data for all capillaries meet the criteria above, click “Accept Results”. If 
any capillary data does not meet the criteria above, click “Reject Results”, and 
refer to the “spectral calibration troubleshooting” section of the Applied 
Biosystems 3500/3500xL Genetic Analyzers User Guide. 

Sample preparation 

1. Set up a mixture of formamide and DNA size standard according to 
Table 38. 

Table 38. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12 µl 

DNA Size Standard 550 (BTO) 0.5 µl 
 

 
2. Aliquot 12 µl of the mixture to a tube for each sample to be 

analyzed. 
3. Add 1 µl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
 
Since injections take place simultaneously on all capillaries, 8 or 24 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples 
are analyzed, the empty positions must be filled with 12 µl Hi-Di Formamide. 
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To ensure a reliable allelic assignment on multi-capillary analyzers, inject one 
allelic ladder for each set of 24 samples: 

 8-capillary instruments: One allelic ladder per 3 injections 

 24-capillary instruments: One allelic ladder per 1 injection  

Room temperature may influence the performance of PCR products on multi- 
capillary instruments, so that shoulder peaks or split peaks occur, especially at 
low temperatures. Ensure ambient conditions are kept, as recommended by the 
instrument manufacturer. 

Setting up a run 

If you are using the Investigator Argus X-12 Kit for the first time on an Applied 
Biosystems 3500 Genetic Analyzer, you will first need to setup a number of 
protocols:  

 Instrument Protocol 

 Size Standard 

 QC Protocol 

 Assay 

All protocols can be set up via the Dashboard of the 3500 Series Data 
Collection software. 

1. To set up the Instrument Protocol, go to “Library” and select 
“Analyze”, followed by “Instrument Protocols” and click “Create”. 
Note: Modify the Run Module Default settings from “HID36_POP4” as 
shown in Table 39. 

2. The parameters in Table 39 must be entered or selected. 
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Table 39. Instrument Protocol parameters for Applied Biosystems 
3500/3500xL Genetic Analyzer 

Parameter Setting 

Application Type HID 

Capillary Length 36 cm 

Polymer POP4 

Dye Set e.g., BT5 

Run Module HID36_POP4 

Protocol Name e.g., Investigator Argus X-12 

Oven Temperature (°C) Default 

Run Voltage (kV) Default  

PreRun Voltage (kV) Default 

Injection Voltage (kV) 3.0 

Run Time (s) 1300 

PreRun Time (s) Default 

Injection Time (s)  8.0* 

Data Delay (s) Default 

Advanced Options Default 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary. 

 
3. Click “Save” to confirm the changes. 
4. To set up the Size Standard, go to “Library”, select “Analyze”, 

followed by “Size Standards”, and click “Create”. 
5. The parameters in Table 40 must be entered or selected. 

The DNA Size Standard 550 (BTO) should be used with the following 
lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 
240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500, 
525, and 550 bp. 
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Table 40. Size standard parameters 

Parameter Setting 

Size Standard e.g., SST-BTO_60-550 

Dye Color Orange 
 

 
6. Click “Save” to confirm the changes. 
7. To set up the QC Protocol, go to “Library” and select “Analyze”, 

followed by “QC Protocols”, and click “Create”. 
8. The parameters in Table 41 must be entered or selected. 

Table 41. QC Protocol parameters 

Parameter Setting 

Protocol Name e.g., BTO_550 

Size Standard SST-BTO_60-550 (from step 4) 

Sizecaller SizeCaller v1.1.0 
 

 
9. Go to “Analysis Settings”, followed by “Peak Amplitude Threshold” 

and disable “Purple”. Ensure that all other colors are enabled. 
Check the recommended analysis settings in Table 44. All other settings 
should remain as “Default”. 

10. Click “Save” to confirm the changes. 
11. To set up an Assay, go to “Library” and select “Manage”, followed 

by “Assays”, and click “Create”. 
12. To analyze Investigator Argus X-12 fragments, the parameters in 

Table 42 must be selected. 
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Table 42. Assay parameters 

Parameter Setting 

Assay Name e.g., Investigator Argus X-12 

Color Default 

Application Type HID 

Instrument Protocol e.g., Investigator Argus X-12 (from step 1) 

QC Protocols e.g., BTO_550 (from step 7) 
 

 

13. Click “Save” to confirm the changes. 

Starting the run 

1. In the Dashboard, click “Create New Plate”.  
2. Go to “Define Plate Properties” and select “Plate Details”. Select or 

enter the parameters in Table 43. 

Table 43. Plate properties 

Property Setting 

Name e.g., Investigator Argus X-12 

Number of Wells 96 

Plate Type HID 

Capillary Length 36 cm 

Polymer POP4 
 

 

3. Click “Assign Plate Contents” to confirm the changes. 
4. Enter the designated sample name in each well containing a sample 

or allelic ladder. This will identify the well positions of each sample 
for the data collection and processing. 

5. Choose the correct Assay for the analysis. If you followed the steps 
under “Setting up the Run”, this would be Investigator Argus X-12 
from step 11. All named wells on the plate must have an assigned 
assay.  

6. Select the wells for which to specify an assay. Check the box next to 
the assay name to assign it to the selected wells.  
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7. (Optional) Repeat for file name conventions and results group. 
8. If not already done, load the assembled plate to the instrument and 

close the instrument door to re-initialize the instrument. Then click 
“Link Plate for Run”. In the next screen, enter the desired Run Name 
and click “Start Run”. 

Analysis parameters/analysis method 
Table 44 lists the recommended analysis parameters in the worksheet Peak 
Detector. 

Table 44. Recommended settings for the Applied Biosystems 
3500/3500xL 

Parameter Settings 

Peak Detection Algorithm Advanced 

Ranges Analysis: Partial Range 

Start Point: 1000; Stop Point: 20,000 

Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  

Baseline Window: 51 pts 

Size Calling Method Local Southern Method 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Slope Thresholds: 0.0 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that 
will be detected by the GeneMapper ID-X Software version 1.2. The thresholds are usually 
50–200 RFU and should be determined individually by the laboratory. Recommendation: 
The minimal peak height should be three-times higher than the background noise of the 
baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 
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Protocol: Analysis 
For general instructions on automatic sample analysis, refer to the appropriate 
User and/or Workflow Guides for Investigator IDproof Software, Investigator 
IDproof Mixture Software, GeneScan, GeneMapper ID, or GeneMapper ID-X 
Software.  

Finding the exact lengths of the amplified products depends on the device type, 
the conditions of electrophoresis, as well as the DNA size standard used. Due to 
the complexity of some loci, determining the size should be based on evenly 
distributed references. The DNA Size Standard 550 (BTO) should be used with 
the following lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 200, 
220, 240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 
500, 525, and 550 bp. 

 

 
Figure 2. Electropherogram of the DNA Size Standard 550 (BTO), fragments with 
lengths in bp. 

Analysis software 
Allele allocation should be carried out with suitable analysis software, e.g., 
QIAGEN Investigator IDproof or IDproof Mixture Software, or Genotyper, 
GeneMapper ID, or GeneMapper ID-X Software in combination with the 
Investigator Template Files available as a download from www.qiagen.com or 
on a CD-ROM (cat. no. 389900), see Table 45 and Table 46. 

The recommended Investigator Template File for Genotyper Software is the 
Argus X-12. 
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Table 45. Recommended Investigator Template Files for GeneMapper ID  

File type File name 

Panels Argus_X12_Panels 

BinSets Argus_X12_Bins 

Size standard SST-BTO_60–500bp 

Analysis Method Analysis_HID_310 

Analysis_HID_3130 

Analysis_HID_310_50rfu 

Analysis_HID_3130_50rfu 

Plot Settings Plots_5dyes 

Table Settings Table for 2 alleles 

Table for 10 alleles 
 

Panels and BinSets must always be used; other template files are optional. 

Table 46. Recommended Investigator Template Files for GeneMapper ID-X  

File type File name 

Panels Argus_X12_Panels_x 

BinSets Argus_X12_Bins_x 

Stutter Argus_X12_Stutter_x 

Size standard SST-BTO_60–500bp 

Analysis Method Analysis_HID_310 

Analysis_HID_3130 

Analysis_HID_310_50rfu 

Analysis_HID_3130_50rfu 

Analysis_HID_3500 

Plot Settings Plots_5dyes 

Table Settings 310 Data Analysis/31xx Data Analysis 
 

Panels and BinSets must always be used; other template files are optional. 
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Controls 
The alleles listed in Table 47 represent the Control DNA 9947A (included in the 
Investigator Argus X-12 Kit) and DNA from other commercially available 
standard cell lines. 

Table 47. Allele assignment of the Investigator Argus X-12 Kit 

Locus CCR 
9947A 

CCR 
9948 

CCR 
3657 

ATCC 
K-562 

Amelogenin X/X X / Y X / Y X/X 

DXS7132 12/12 13 12 13/13 

DXS7423 14/15 14 13 17/17 

DXS8378 10/11 11 12 10/10 

DXS10074 16/19 18 7 17/17 

DXS10079 20/23 19 19 17/17 

DXS10101 30/31 32 29.2 31/31 

DXS10103 17/17 18 20 17/17 

DXS10134 35 /36 34 34 32/32 

DXS10135 21.1/27 22 25 27/27 

DXS10146 28/28 29 27 29 / 29 

DXS10148 22.1/23.1 23 23.1 23.1/23.1 

HPRTB 14/14 14 13 13/13 
 

 

For further confirmation, the table displays the alleles of the reference DNA 
purchased from Coriell Cell Repositories (CCR), as well as 3 reference DNAs 
purchased from CCR and ATCC up to the standard of Szibor et al. (4). 
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Lengths of fragments and alleles 
Table 48 shows the alleles of the allelic ladder. All analyses have been 
performed using an Applied Biosystems 3500 Genetic Analyzer with POP-4 
polymer (Figure 3 and Figure 4, page 55). Different analysis instruments, DNA 
size standards, or polymers may result in different fragment lengths. In addition, 
a visual alignment with the allelic ladder is recommended. 

Scaling 

 Horizontal: 75–405 bp  

 Vertical: Depending on signal intensity 
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Table 48. Allelic ladder fragments included in the Investigator Argus 
X-12 Kit 

Locus Dye label Repeat numbers of allelic ladder 

Amelogenin 6-FAM X, Y 

DXS10103 6-FAM 15, 16,17, 18, 19, 20, 21 

DXS8378 6-FAM 9, 10, 11, 12, 13, 14, 15 

DXS7132 6-FAM 10, 11, 12, 13, 14, 15, 16, 17 

DXS10134 6-FAM 28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 
38.3, 39.3, 40.3, 41.3, 42.3, 43.3, 44.3 

DXS10074 BTG 4, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 16.2, 
17, 18, 19, 20, 21 

DXS10101  BTG 24, 24.2, 25, 25.2, 26, 26.2, 27, 27.2, 28, 
28.2, 29, 29.2, 30, 30.2, 31, 31.2, 32, 
32.2, 33, 33.2, 34, 34.2, 35 

DXS10135  BTG 13, 14, 16, 17, 18, 19, 20, 21, 22, 23, 24, 
25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 
36, 37.2, 39.2 

DXS7423 BTY 13, 14, 15, 16, 17, 18 

DXS10146  BTY 24, 25, 26, 27, 28, 29, 30, 31, 32, 32.2, 
33, 33.2, 34, 34.2, 35.2, 39.2, 40.2, 41.2, 
42.2, 43.2, 44.2, 45.2, 46.2 

DXS10079  BTY 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 25 

HPRTB BTR 9, 10, 11, 12, 13, 14, 15, 16, 17 

DXS10148  BTR 13.3, 18, 19, 20, 21, 22.1, 23.1,  24.1, 
25.1, 26.1, 27.1, 28.1, 29.1, 30.1, 31, 
38.1 

 

 

For information about known microvariants not contained in the Investigator 
Argus X-12 Allelic Ladder, see the National Institute of Standards and 
Technology (NIST) web site (www.cstl.nist.gov/biotech/strbase/).  
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Figure 3. Electropherogram of the Investigator Argus X-12 Kit using 500 pg Control 
DNA 9947A. Analysis was performed on an Applied Biosystems 3500 Genetic Analyzer. 
Allele assignment was performed using Investigator IDproof Software. 

 

 
 
Figure 4. Electropherogram of the allelic ladder Argus X-12 analyzed on an Applied 
Biosystems 3500 Genetic Analyzer. Allele assignment was performed using Investigator 
IDproof Software. 
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Interpretation of Results 
Post-PCR analysis and automatic allele assignment with suitable analysis 
software ensure a precise and reliable discrimination of alleles. 

General procedure for the analysis 

1. Check the DNA size standard. 
2. Check the allelic ladder. 
3. Check the positive control. 
4. Check the negative control. 
5. Analyze and interpret the sample data. 

Pull-up peaks 

Pull-up peaks may occur if peak heights are outside the linear detection range 
(see “Troubleshooting Guide”, page 60), or if an incorrect matrix was applied. 
They appear at positions of specific peaks in other color channels, typically with 
lower signal intensities. Peak heights should not exceed 3000 RFU in order to 
prevent pull-up peaks.  

Stutter peaks 

The occurrence of stutter peaks depends on the sequence of the repeat structure 
and the number of alleles. n –4 peaks are caused by a loss of a repeat unit during 
amplification of tetranucleotide STR motifs, caused by slippage effects of the Taq 
DNA polymerase. These peaks should be interpreted using the Investigator 
Template Files for Genotyper, GeneMapper ID, and GeneMapper ID-X Software. 

Template-independent addition of nucleotides 

Because of its terminal transferase activity, the Taq DNA polymerase may cause 
incomplete adenylation at the 3'-end of the amplified DNA fragments. The artifact 
peak is one base shorter than expected (–1 peaks). All primers included in the 
Investigator Argus X-12 Kit are designed to minimize these artifacts. Artifact 
formation is further reduced by the final extension step of the PCR protocol at 68°C 
for 60 minutes. Peak height of the artifact correlates with the amount of DNA. 
Laboratories should define their own limits for analysis of the peaks. 

Artifacts  

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder or 
split peaks appear, we recommend injecting the sample again. 
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Characteristics and Use of X-chromosomal STRs  
In principle, the guidelines of the ISFG (www.isfg.org) are also valid for working 
with X-chromosomal STRs. However, the following points should be noted:  

 Typing of X-chromosomal markers is only permissible when the phenotypic 
and genetic sex is identical.  

 The genetic sex can easily be determined by analysis of the Amelogenin locus.  

 If the phenotypic sex differs from the genotypic sex, results from ChrX-
typing may not be used.  

 Following national laws, this information must be held in the strictest 
confidential and should only be forwarded to the analyzed person on request. 

 Generation of X-chromosomal profiles for kinship testing should be taken into 
account whenever autosomal markers do not give reliable or unequivocal 
results, notably in deficiency cases. In some instances, e.g., for complex 
kinship and paternity testing, markers located on the sex chromosomes may 
be more informative than their autosomal counterparts, and the use of sex-
chromosomal markers may therefore substantially improve the efficiency of a 
kinship test. This is because the mean exclusion chance (MEC) of a X-
chromosomal marker (see below for calculation) is consistently larger than 
that of an autosomal marker with the same allele frequencies. 

Calculation of population-genetic data 
The Forensic ChrX Research Group initiated the online database “ChrX-
STR.org” (www.chrx-str.org) that calculates population genetics data on the 
basis of X-chromosomal allele frequencies (1). 

The formula for calculating polymorphism information content (PIC) was 
published by Botstein et al. (5), and the formula for expected heterozygosity 
(HET) by Nei and Roychoudhury (6). Both can be used for autosomal or 
X-chromosomal markers.  

Krüger et al. (7) introduced the formula for the MEC — the MECKrüger, which was 
developed for either autosomal marker or for trios. With exception of deficiency 
cases, MECKrüger is not suitable for X-chromosomal markers. Here, the paternal 
grandmother can be analyzed instead of the putative father. Kishida et al. (8) 
devised the MECKishida for X-chromosomal markers as regards trios including a 
daughter. In comparison with MECKrüger, MECKishida is more complex highlighting 
the fact that in trios involving a daughter X-STRs are more efficient then 
autosomal markers.  
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Finally, Desmarais et al. (9) introduced formulae for the MEC of ChrX markers 
in trios involving daughters, as well as in father–daughter duos without 
information about the maternal genotype. MECDesmarais is equivalent to MECKishida 
whereas MECDesmarais Duo can also be used for maternity testing of mother–son 
duos. The formula for calculation of the power of discrimination was published 
by Desmarais et al. (9). 
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MECKishida = Σi fi3 (1 - fi) + Σi fi (1 - fi)2 + Σi<j fi fj (fi + fj) (1- fi – fj )  

MECDesmarais = 1 - Σi fi2 + Σi fi4 – (Σi<j fi2)2  

MECDesmarais Duo = 1 - 2Σi fi2 + Σi fi3 

PDfemale = 1 – 2(Σi fi2)2 + Σi fi4 

PDmale = 1 – Σi fi2 

Linkage groups 

In contrast to earlier findings (10), recent studies (11, 12) showed that markers 
of linkage groups 3 (HPRTB, DXS10101) and 4 (DXS10134, DXS7423) cannot 
be regarded as unlinked. The possibility of linkage between these markers 
should be considered in calculation and interpretation of relationship tests in 
deficiency cases. If necessary, both probabilities should be calculated from the 
linkage groups 1, 2, and 3 and linkage groups 1, 2, and 4. For use and 
calculation of X-chromosomal markers see reference 13 and 
http://linkage.rockefeller.edu. 

Kinship tests and paternity cases with ChrX STRs  

Note: X-chromosomal markers are particularly informative for inferring parent–
offspring relationships that involve at least one female, i.e., mother–daughter, 
mother–son, and father–daughter duos. For paternity cases only, testing 
between father and daughter is possible, since fathers pass on only their X-
chromosome to their daughter, whereas sons inherit the X-chromosome from 
their mother. 
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Deficiency cases 

If the putative father (PV) descends from the putative grandmother (PGM) 
without any doubt, his X-chromosomal characteristics originate from the PGM. 
Therefore, she (PGM) can be analyzed X-chromosomally instead. The 
calculation of the PGM-likelihood with X-chromosomal markers (PGM-
daughter) may be performed like the calculation with autosomal markers (PV-
daughter). Here, the MEC values according to the formula of Krüger et al., (7) 
are applied, whereas only unlinked X-STR markers of the Investigator Argus X-
12 Kit can be used. For markers which are in coupling equilibrium, haplotype 
frequencies must be involved for calculation.  

Siblings and distant relationships 

The X-chromosomal analysis (i.e., without parental samples) cannot be used as 
relationship test in the following cases: 

 Different putative fathers may be the father of the child  

 Half-brothers with same father and different mothers  

 Brothers and half-brothers with same mother (statistically, they have 50% of 
the characteristics in common, thus the test is comparable to a test with 
autosomal markers)  

Whenever distant relationship should be analyzed, genotyping of X-chromosomal 
markers is very useful, because the usage of coupled markers allows ChrX-
haplotyping. Three markers of each linkage group from the Investigator Argus 
X-12 Kit have to be handled as haplotype for genotyping. For further details, see 
reference 10, or for the calculation, see the online data base “ChrX-STR.org” 
(www.chrx-str.org). 

Use of X-chromosomal markers for forensic traces 

In most cases, the use of autosomal markers for profiling is more reliable since 
all autosomal loci have two alleles. Whenever female DNA traces require 
analysis in a male background, e.g., female traces under the fingernails of 
male, X-chromosomal markers are advantageous. The likelihood that one allele 
of the trace is covered by the male background is only half in comparison to 
autosomal tests.  

Note: International DNA databases do not usually include markers of the 
X-chromosome.  
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Troubleshooting Guide 
This troubleshooting guide may be helpful in solving any problems that may 
arise. For more information, see also the Frequently Asked Questions page at 
our Technical Support Center: www.qiagen.com/FAQ/FAQList.aspx. The 
scientists in QIAGEN Technical Services are always happy to answer any 
questions you may have about either the information and protocols in this 
handbook or sample and assay technologies (for contact information, see back 
cover or visit www.qiagen.com).  

 Comments and suggestions 

Sample preparation 

Sample signal intensity 
must be increased 

Reduce the volume of the DNA Size Standard 
550 (BTO) to peak heights of about 500 RFU.  

Purify the PCR products before starting the 
analysis. We recommend the MinElute® PCR 
Purification Kit for rapid and effective purification 
(see Ordering Information). 

Matrix/spectral calibration is not appropriate 

 There are pull-up 
peaks between the dye 
panels (B, G, Y, R, O) 
with the current matrix/ 
spectral calibration 

This matrix cannot be used for the analysis. 
Repeat the matrix generation/spectral 
calibration. Be sure to carefully follow the correct 
protocol for the specific analysis instrument. 

Many peaks are labeled as off-ladder (OL) alleles in the samples 

a) DNA Size Standard 
550 (BTO) was not 
defined or identified 
correctly 

Click the orange “Size Match Editor“ icon in the 
upper toolbar or the GeneMapper ID or 
GeneMapper ID-X Software. Mark the orange 
fragments of all samples.  

Always use the DNA Size Standard 550 included 
in Investigator Human Identification PCR Kits. 
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 Comments and suggestions 

b) Signal intensities are 
too high. If the peak 
heights of the samples 
are outside the linear 
detection range 
(>4000 RFU/>5000 
RFU*), stutters, split 
peaks, and artifacts 
may be increased 

Reduce the injection time in increments to a 
minimum of 1 s, reduce the amount of the PCR 
amplification product for analysis, or reduce the 
quantity of DNA for PCR. 

c) Bubbles in the capillary 
lead to pull-up peaks 
in all color panels 
(“spikes”) that result in 
allele misnomer 

Repeat electrophoresis to confirm results. 

d) Differences in the run 
performance among 
the capillaries of a 
multi-capillary analyzer 
may result in allelic 
assignment shift 

For reliable allelic assignment on multi-capillary 
analyzers, a number of allelic ladders should be 
run. 

 

e) Use of 32-cycle PCR 
program for small 
amounts of DNA 

Too small amounts of DNA may result in allelic 
dropouts and imbalances of the peaks. 
Furthermore, unspecific amplification products 
may appear. By increasing the number of cycles, 
there is a risk of cross-contamination due to 
impurities. 

Injection/file of the allelic ladder is not appropriate 

a) An additional signal 
can be identified as 
peak of the allelic 
ladder because of 
dysfunctions during the 
electrophoresis. If 
peaks of the allelic 
ladder are miscalled, 
the ladder cannot be 
used for the analysis 

Use a different injection/file of the allelic ladder 
and check the data of the analyzed sizes from 
the Size Standard (in bp) of the allelic ladder.  

Always use the DNA Size Standard 550 included 
in Investigator Human Identification PCR Kits. 

 

* >4000 RFU for the ABI PRISM 310 Genetic Analyzer; >5000 RFU for the ABI PRISM 3100 
and Applied Biosystems 3130/3500 Genetic Analyzers. 
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 Comments and suggestions 

b) One peak of the allelic 
ladder is below the 
peak detection value 
(50–200 RFU) of the 
analysis method used, 
and thus, is not 
identified 

The allelic ladder must be loaded onto the 
analysis instrument at a higher concentration 
than samples to be analyzed.  

Alternatively, allelic ladder data can be analyzed 
with a lower peak detection value in Analysis 
Software. 

c) One peak of the allelic 
ladder is not identified 
because it is outside 
the expected size range 
of the software (in bp) 

Compare the length of the fragments (in bp) of 
the first allele in one color of the allelic ladder 
with the corresponding value in the categories. 
Then compare it with the other alleles. 

d) Point alleles are not 
found 

Point alleles are i.e., alleles with at least 1 bp 
difference to the next integer allele. Check the 
settings of the analysis method. Lower the Peak 
Window Size value to 11 points. 
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QIAGEN maintains a large, up-to-date online database of scientific 
publications utilizing QIAGEN products. Comprehensive search options allow 
you to find the articles you need, either by a simple keyword search or by 
specifying the application, research area, title, etc. 

For a complete list of references, visit the QIAGEN Reference Database online 
at www.qiagen.com/RefDB/search.asp or contact QIAGEN Technical Services 
or your local distributor. 
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Ordering Information  
Product Contents Cat. no. 

Investigator Argus 
X-12 Kit (25) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

383213 

Investigator Argus 
X-12 Kit (100) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

383215 

Related products  

Investigator Human Identification PCR Kits  

Investigator Argus 
Y-12 QS Kit (100)*  

 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

383615 

Investigator 
ESSplex Plus Kit 
(100)* 

Primer mix, Fast Reaction Mix including 
HotStarTaq® Plus DNA Polymerase, 
Control DNA, allelic ladder ESSplex 
Plus, DNA size standard 550 (BTO), 
and nuclease-free water 

381535 

Investigator 
ESSplex SE Plus Kit 
(100)* 

Primer mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder ESSplex SE 
Plus, DNA size standard 550 (BTO), 
and nuclease-free water 

381545 

Investigator IDplex 
Plus Kit (100)* 

Primer mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder IDplex Plus, 
DNA size standard 550 (BTO), and 
nuclease-free water 

381625 

Investigator 
HDplex Kit (100) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

381215 

* Larger kit sizes available; please inquire. 
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Product Contents Cat. no. 

Investigator Triplex 
AFS QS Kit (400) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

380317 

Investigator Triplex 
DSF Kit (400) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

380327 

Investigator 
DIPplex Kit (100)* 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

384015 

Investigator Quantification Kits  

Investigator 
Quantiplex Kit 
(200) 

Primer mix IC FQ, reaction mix FQ, 
Control DNA Z1, dilution buffer 

387016 

Investigator 
Quantiplex HYres 
Kit 

Primer mix IC YQ, reaction mix FQ, 
Control DNA Z1, dilution buffer 

387116 

Investigator Human Identification PCR Kit Accessories  

DNA Size 
Standard 550 
(BTO) (100) 

DNA Size Standard 550 (BTO) for 100 
reactions 

386015 

Matrix Standard 
BT5 single cap. (5 
x 25) 

Matrix standard 6-FAM, BTG, BTY, 
BTR, and BTO 

386113 

Matrix Standard 
BT5 multi cap. 
(25) 

Matrix standard 6-FAM, BTG, BTY, 
BTR, and BTO 

386123 

Matrix Standard 
BT5 multi cap. 
(50) 

Matrix standard 6-FAM, BTG, BTY, 
BTR, and BTO 

386125 

Multi Taq2 DNA 
Polymerase (100) 

100 Units Multi Taq2 DNA Polymerase 386315 

* Larger kit sizes available; please inquire. 
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Product Contents Cat. no. 

Analysis 
software 

  

Investigator 
IDproof Software 

Software package on CD including 
installation files for the Desktop, Server 
and Client versions of IDproof 
Software 

9020775 

Investigator 
IDproof Demo Key 

Free use of the IDproof Desktop 
version of the software for 30 days 
after installation 

389001 

Investigator 
IDproof Single Key 

Allows the unlimited use of the 
Desktop version of the software; to be 
installed on a single workstation with a 
local database 

389002 

Investigator 
IDproof Server Key 

Allows for setup of a server that 
maintains the database and various 
workstations to access that database. 
Must be purchased in conjunction with 
the Client Key 

389003 

Investigator 
IDproof Client Key 

Must be purchased in conjunction with 
the Server Key 

389004 

Investigator 
IDproof Mixture 
Software 

Software package on CD including 
installation files for the Desktop, Server 
and Client versions of IDproof Mixture 
Software 

9020777 

Investigator 
IDproof Mixture 
Demo Key 

Free use of the IDproof Mixture 
Desktop version of the software for 30 
days after installation 

389401 

Investigator 
IDproof Mixture 
Single Key 

Allows the unlimited use of the 
Desktop version of the software; to be 
installed on a single workstation with a 
local database 

389402 

Investigator 
IDproof Mixture 
Server Key 

Allows for setup of a server that 
maintains the database and various 
workstations to access that database. 
Must be purchased in conjunction with 
the Client Key 

389403 
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Product Contents Cat. no. 

Investigator 
IDproof Mixture 
Client Key 

Must be purchased in conjunction with 
the Server Key 

389404 

Investigator 
Template Files  

Template files for Investigator Human 
Identification PCR Kits for use with 
GeneMapper ID, GeneMapper ID-X, 
and Genotyper Software, plus 
DIPSorter freeware (CD-ROM) 

389900 

DNA extraction and purification  

QIAamp® DNA 
Investigator Kit 
(50) 

50 QIAamp MinElute Columns, 
Proteinase K, Carrier RNA, Buffers, 
Collection Tubes (2 ml) 

56504 

EZ1® DNA 
Investigator Kit 
(48) 

Reagent Cartridges, Disposable Filter-
Tips, Disposable Tip-Holders, Sample 
Tubes (2 ml), Elution Tubes (1.5 ml), 
Buffer G2, Proteinase K, Carrier RNA 

952034 

MinElute PCR 
Purification Kit 
(50)* 

50 MinElute Spin Columns, Buffers, 
Collection Tubes (2 ml) 

28004 

 

For up-to-date licensing information and product-specific disclaimers, see the 
respective QIAGEN kit handbook or user manual. QIAGEN kit handbooks and 
user manuals are available at www.qiagen.com or can be requested from 
QIAGEN Technical Services or your local distributor. 

* Larger kit sizes available; please inquire. 

68 Investigator Argus X-12 Handbook   06/2013 

 

http://www.qiagen.com/


 

Notes 

Investigator Argus X-12 Handbook   06/2013 69 



Notes 

 

70 Investigator Argus X-12 Handbook   06/2013 



 

Trademarks: QIAGEN®, QIAamp®, EZ1®, HotStarTaq®, Investigator®, MinElute®, Rotor-Gene® (QIAGEN Group); 3500™, ABI PRISM®, Applied 
Biosystems®, Avant™, GeneAmp®, GeneMapper®, GeneScan®, Genotyper®, 6-FAM™, POP-4™, Hi-Di™ (Applera Corporation or its subsidiaries); 
Eppendorf®, Mastercycler® (Eppendorf AG); GenBank ® (US Department of Health and Human Services). Registered names, trademarks, etc. used in 
this document, even when not specifically marked as such, are not to be considered unprotected by law. 

Limited License Agreement for the Investigator Argus X-12 Kit 

Use of this product signifies the agreement of any purchaser or user of the product to the following terms: 

1. The product may be used solely in accordance with the protocols provided with the product and this handbook and for use with components 
contained in the kit only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this 
kit with any components not included within this kit except as described in the protocols provided with the product, this handbook, and 
additional protocols available at www.qiagen.com. Some of these additional protocols have been provided by QIAGEN users for QIAGEN 
users. These protocols have not been thoroughly tested or optimized by QIAGEN. QIAGEN neither guarantees them nor warrants that they do 
not infringe the rights of third-parties.  

2. Other than expressly stated licenses, QIAGEN makes no warranty that this kit and/or its use(s) do not infringe the rights of third-parties. 

3. This kit and its components are licensed for one-time use and may not be reused, refurbished, or resold. 

4. QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated. 

5. The purchaser and user of the kit agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited 
above. QIAGEN may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court 
costs, including attorney fees, in any action to enforce this Limited License Agreement or any of its intellectual property rights relating to the kit 
and/or its components. 

For updated license terms, see www.qiagen.com. 

© 2010–2013 QIAGEN, all rights reserved. 

 

 

http://www.qiagen.com/


 

www.qiagen.com 

Australia  techservice-au@qiagen.com 

Austria  techservice-at@qiagen.com 

Belgium  techservice-bnl@qiagen.com 

Brazil  suportetecnico.brasil@qiagen.com 

Canada  techservice-ca@qiagen.com 

China  techservice-cn@qiagen.com 

Denmark  techservice-nordic@qiagen.com 

Finland  techservice-nordic@qiagen.com 

France  techservice-fr@qiagen.com 

Germany  techservice-de@qiagen.com 

Hong Kong  techservice-hk@qiagen.com 

India  techservice-india@qiagen.com 

Ireland  techservice-uk@qiagen.com 

Italy  techservice-it@qiagen.com 

Japan  techservice-jp@qiagen.com 

Korea (South)  techservice-kr@qiagen.com 

Luxembourg  techservice-bnl@qiagen.com 

Mexico  techservice-mx@qiagen.com 

The Netherlands  techservice-bnl@qiagen.com 

Norway  techservice-nordic@qiagen.com 

Singapore  techservice-sg@qiagen.com 

Sweden  techservice-nordic@qiagen.com 

Switzerland  techservice-ch@qiagen.com 

UK  techservice-uk@qiagen.com 

USA  techservice-us@qiagen.com 
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